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Introduction
You use Solids Import to read files that contain solid and surfacemodels, makeminor modifications
to themodel, and extract geometry from themodel to createmachining operations. This resource
provides reference and procedural information. For instructional exercises, see Solids Import
Tutorials.

This resource assumes that you have a basic level of proficiencywith geometry creation, coordinate
systems, andmachining. Advanced CS is not required, but addsmore complete functionality to
Solids Import. For more information about GibbsCAM, see theGeometry Creation, Mill, and
Advanced CS guides.

Definitions
The terms and definitions provided below are used to describe objects and elements used by the
system, and throughout this guide.

Body
The term “body” is a generic term that refers to both solids and sheets. A solid body can be thought
of as a bowling ball, while a sheet body ismore like a balloon with an infinitely thin wall.

Face
A face is one surface of a solid or sheet. A Sheet face includes the positive and negative sideswhile
a solid only includes the positive side. Faces are surfaces that have knowledge of the surfaces that
surround them. For example, one side of a cube would be considered a face. Each face is bound by
loops. A simple face is bounded by one loop.

Surface
A surface is either a face, group of faces (depending on how the surface was created) of a solid or
side of a sheet. Sheets have two surface sides and a solids have only one.

Solid
A solid is a body composed of faces and the area enclosed by the faces. Solids have volume. Solids
bodies are used as the building blocks in creating part models in GibbsCAM. Unlike sheets, solids
only have a positive side.

Sheet
A sheet is an surface with two sides, positive and negative. A sheet has no volume or thickness
associated with it.

Edge
An edge is a curve/line between two faces. An edge of a solid must have exactly two faces
connected to it. Note that more than two faces at an edge produces an invalid solid. The edge of a
sheet can have a single face connected to that.

Loop
A loop is a series of connected edges that outline a face.
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Vertex
A vertex is an endpoint of an edge.
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Solids Import
l “WorkingWith Bodies” on page 7
l “BodyMenu Items” on page 9
l “Extracting Geometry fromSolids ” on page 24

Working With Bodies
A 3D body can bemade up of solids or sheets. Bodies can have geometry extracted from them for
machining. The Solid Import option allows users to import bodies andmachine themwithout the
SolidSurfacer option. In this first section wewill discuss the interface items and details of 3D
models. In the second section wewill discuss the tools to extract geometry to machine themodel.

Solids
Solid models have volume. Solids can either be viewed aswireframe drawings but only rendered
objects can be selected.

Sheets
Sheets do not have any thickness or volume. A sheet has knowledge of the neighboring sheets that
surround it. Sheetsmay have either one face or several faces. Similar to solids, sheetsmay also be
defined as a part, stock, or fixture. When a surface files is imported, each surface entity is brought in
as a single sheet.

Lumps
Each body is either a single conjoined object called a lumps or a disconjoined single object, called a
multi-lump body. Multi-lump solids can be separated to create single lump bodies. See the
Separate function on the following page.

Workspace
Bodies exist in the workspace or the Body Bag (when visible). Bodies are not contained in
workgroups . Bodies are assigned to the coordinate system theywere created in.

Floating Toolbar

The Floating Toolbar contains five items that are part of the Solids Import interface. For more
detailed information on these Floating Toolbar items, see the Interface section in the Getting
Started guide.
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1. Show Solids
2. Render/Wireframe
3. Indicate Sheet Side

4. Face Selection
5. Edge Selection

Show Solids
This button will show and hide all bodies, including sheets.

Render/Wireframe
Render fully shaded objects or simple wireframe.

Indicate Sheet Side
Indicate the positive and negative sides of a sheet.

Face Selection
Enable/disable face selectionmode.

Edge Selection
Enable/disable edge selectionmode.

Commands Palette

Two buttons in the Commands palette are part of themain functionality of Solid Import. The

Surface and Solid Modeling palettes help to create andmodify bodies and the Body Bag

is an organizational container for bodies

Solid Modeling Palette

Click the Solid Modeling button in the Commands palette to open Solid Modeling. All of the
modeling functions that are used with solids are accessed from this palette. The Solid Import
options allows the use of slicing and separating solids and sheets.
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1. Slice
2. Separate

Slice
This function slices selected solids or sheets into separate entities. The slicing entity can either be
the current Coordinate System (CS) or a selected sheet. When using a sheet as the slicing tool, the
sheet must extend all the way through the target. If a solid and sheet are selected when this button
is clicked, the bodywill be sliced into two separate bodieswhere the selected sheet intersects the
body. Likewise, if two sheets are selected, the first sheet selected will be sliced where the second
intersects the first. Slicing a solid with a sheet is a type of Boolean operation; therefore, the sheet
will be destroyed or deleted once the slicing operation is complete. The slicing function also works
only if a solid or sheet is selected. In that case, the solid or sheet will be sliced with the current
coordinate system. It is recommended that slicing operations be performed as early in themodeling
process as possible due to the fact that coordinate systems and planes act as very big (potentially
infinite) kniveswhen slicing andmay unintentionally slice other entities.

Separate
This function will separate a selectedmulti-lumped bodies.

Body Menu Items
l Edit on page 9
l Modify on page 10

Edit

Select Special
The Select Special sub-menu contains items that enable you to limit your selections to only certain
items. TheWalls From Selected command selects all faces that are tangent to the selected edges and
perpendicular to the current CS. By Body Name and By Body Comment allow selection of bodies by
name or comment in their respective dialogs.
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Deselect Special
The Deselect Specialmenu contains similar items to the Selectmenu but acts by deselecting (instead
of selecting) entities.

Modify

Shrinkage:
Shrinkage compensates for the rate at which an injection substance
shrinks in amold cavity. It performs a uniform or axial reduction or
enlargements on selected solids. The range of shrinkage is -10% to
10%. Shrinkage can also be applied differently in each axis.

FINAL SIZE = (100 - SHRINKAGE%) * START SIZE /100

Toggle Sheet Side:
This item is useful when solidifying sheets into solids using theOffset
solidify option. When sheets are converted into solids by offsetting, the offset must be calculated
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from one side of the sheet or the other. TheMax andMin offset values are referenced from one side
of the sheet. To offset the sheet from the other side, select the sheet and then select the Toggle
Sheet Side item.

Context Menus
You can access context menus by right-clicking on a body or edge.

l “BodyContext Menu ” on page 11
l “Edge Context Menu ” on page 14

Body Context Menu 

To access the body context menu, right-click on a body or history entry.

Bag It/Un-Bag It:
Bag It places a selected body into the Body Bag. If the body is in the Body Bag, Un-Bag It item places
it in the workspace. This function does not apply to multiple selections. For multiple selection
functions, see “Multiple Body Properties” on page 17.
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Bag/Un-Bag Selected:
Moves all selected bodies into or out of the Body Bag.

Body Type

Designate the selected solid as Part, Stock, Fixture, Stock - Display Only,
Fixture - Display Only. For more detail on these selections, see “Multiple Body Properties” on
page 17.

Show Properties:
Opens the Properties dialog for a solid or sheet. For more information, see “Properties” on
page 15.

Show Properties of Selected:
Shows the properties of all currently selected bodies. See “Properties” on page 15 and “Multiple
Body Properties” on page 17.

User Color:
Enables custom color display of individual edges or faces. See “Properties” on page 15 and
“Multiple Body Properties” on page 17.

User color of Selected:
Change the color of all currently selected faces or bodies. See “Properties” on page 15 and
“Multiple Body Properties” on page 17.

Recreate:
The Recreatemode takes the selected body back to its creation action to bemodified. The selected
body is drawn in red and any changesmadewill permanently replace the selected body. To
cancel Recreatemode, right-click a body and choose Exit Recreate or click the red body.

Rebuild:
Reprocesses the History list and incorporates any changesmade using Recreate, Swap, or
Replace into a new final part model. The Rebuild function is limited in that models cannot be rebuilt
if the changes require a significant alteration to the topology. For example, if the change created
any new edges, the final model cannot be rebuilt.

Show History:
The History list displays the creation process of the selected body. All bodies used to create the
selected body appear in the History list. To restore a dormant body in the History list to the
Workspace, double-click the icon in the History list.

Clear History:
Clears the history of the selected body, essentially turning the solid into an atomic body. You
cannot undo this action.
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Extract Edges:
Extracts the selected edges and creates geometry from them. Please note thismay take some
time depending on the amount of geometry selected.

Align Face To CS:
When Face Selection is active, you can
choose a face and align it to the current CS.
Right-click a face to select this command.
Choosing this command orients the part to
the CS as if the following stepswere taken.
a. Create a new CS from the target CS,

that is, the CS you want to align to.

b. Select a planar, cylindrical, or complex
face.

c. Select Align Plane Through& Move (right
mousemenu choice) or Alt-click the
Align CS button. For a cylinder, use
Align CS Normal & Move.

d. Apply theModify CS (XYZ) command to the solid to assign it to the new CS.

e. Select the target CS.

f. Apply theModify CS (HVD) command to the solid to assign it to the target CS andmove it.

g. Delete new CS.

Face Selection Mode Options

The following items for selecting and deselecting faces are only available when the system is in
Face Selectionmode. These options are useful whenmultiple facesmust be selected for modeling
or machining functions, and frees you from having to select one face at a time.

Tangent Faces:
Selects or deselects the target face and all of the faces reachable by a tangency.

Faces Above:
Select/deselect neighboring faces if they have an upper boundary that lies above the upper
boundary of the target face. Next it will branch out to the adjoining faces of the neighboring faces
and repeat the selection/deselection using the neighbors upper boundary as the condition (rather
than the target face). A special condition exists for flat faces that neighbor the target face. They
are selected/deselected based on the lower boundary of the target face.

Faces Below:
Select/deselected neighboring faces if they have an lower boundary that lies below the lower
boundary of the target face. Then, it will use the adjoining faces boundary and repeat the
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selection/deselection. However, adjoining flat faces are selected/deselected based on the upper
boundary of the target face.

Floor Faces:
Select/seselect all floor faces connected to the target face. A floor face is approximately normal to
the depth axis of the current CS; the approximation is set by the Floor/Wall Angle Tolerance value
set in File > Preferences > Interface > Selection.

Wall Faces:
Select or deselect the target face and any connected face that is parallel to the depth of the
current CS. Angled walls that fall within the Floor/Wall Angle Tolerance value set in File >
Preferences > Interface > Selection are also selected.

3D Faces:
Select/deselect faces connected to the target face that are not defined as a floor or wall. Next it
will branch out to the adjoining faces and select/deselect them using the same logic.

Transition Faces:
Select/deselect all transition faces connected to the target face. A transition face is a smooth
blend that is connected to a wall and floor face.

Fillets:
Select/deselect all constant radius fillet faces that are connected to the target face. The target
face is also selected. The system only selects fillets that have the same constant radius as the
target face if the target face is a fillet.

Edge Context Menu 

Right-click a selected edge to access options that affect edge selection.
When you double-click an edge, the system tries to build a closed loop of
edges starting with the selected edge. The 2D Chain and 3D Chain options
affect how the system chooses the next edge to be connected at each
vertex.

2D Chain:
When you select this option, double-clicking an edge attempts to select
a loop of edges that are planar to the current CS (or those closest to it),
resulting in a 2D loop. If there ismore than one possible choice for an edge at a vertex, the system
chooses the one that is closest to the same direction.

3D Chain:
When you select this option, double-clicking an edge attempts to select a loop of edges that are
normal to the current CS (or those closest to it), resulting in a 3D loop.

User Color:
This allows you to assign colors to individual edges.
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Select Other:
This displays a list of edges that intersect with the selected. Scroll list to choose. You can also
choose the entire solid.

Properties

Body Information

You access the Properties dialog from the body context menu. For more information, see Body
Context Menu .

The Properties dialog contains items that apply to the selected body. You can change the name of
the solid or sheet and enter a comment. The coordinate system that was last modified for the
selected solid or sheet appears at the top of the dialog. The ID is a system-assigned positive integer
that uniquely identifies each body. The CreationMethod lists the action that was used to create the
current body, such as Import, Sphere, Extrude, and so forth.

When the Properties dialog is open, you can select different bodies and the Properties dialog updates
to reflect the body selected. You can select bodies in the History dialog to view in the Properties
dialog by selecting the cube icon in the History list.

Part, Fixture, or Stock

Solids and sheets can be designated as Part, Fixture, or Stock. Additionally there are the Fixture -
Display Only and Stock - Display Only options.When solids and sheets are created, they are
designated as a Part by default unless the setting is changed in this dialog. Solids or sheets
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designated as a Fixture are rendered in red and are used as constraints when creatingmachining
operations. Solids and sheets designated as Stock are rendered in dark blue and are used as the
initial stock condition when creatingmachining operations.

Fixture-DisplayOnly and Stock-DisplayOnly display a body as a fixture or stock, and are used in
rendering, but are not used in the toolpath generation calculation. When any stock or fixture bodies
are present, the systemmay attempt to use 3D toolpath rather than 2D in some cases. The need to
account for potentially hundreds of fixture bodieswhen generating toolpath can slow down system
performance. Using DisplayOnly stock and fixtures settings can greatly improve system
performance, making this feature very important for TMS.

Chord Height

Chord Height sets the degree of render faceting for the selected solid or sheet. To change the chord
height, enter a value and click the Apply button. This value only applies to the selected solid or
sheet. For more information, see Render Faceting.

Physical Properties

The Physical Properties section provides surface area calculations for solids and sheets, volume
calculations for bodies, and surface periphery calculations for sheets. The Physical Properties section
includes an Accuracy slide bar and a Calculate button. The Accuracy slide bar designates the amount
of processing time and effort to allocate for the calculations.With the slide bar closer to the negative
end of the spectrum, the calculations are less accurate and vice versa. Note that all calculations fall
within a certain set range of accuracy, regardless of the setting of the accuracy slide bar.

The percentage values do not directly correlate to the calculation, in that a 0% accuracy still
provides a reasonably accurate calculation. The Accuracy setting affects the calculation processing
time. As bodies becomemore complex, the calculation time increases. In those cases, it may be
desirable to designate a lower accuracy in order to speed up the process. The system always
provides the +/- accuracy tolerance so that you canmonitor the accuracy of calculations.

The following are conversion values for taking the volume in cubic inches, as shown in the Properties
dialog, to measurements in ounces and liters.

1 cubic inch = 0.55409 oz.

1 oz. = 29.57353 ml

Solid Propertiesmeasurements
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Multiple Body Properties

TheMultiple Body Properties dialog appears when you select more than one body and then select
the Properties command. You use this dialog to assign properties tomany bodies at once.

Add or change bodies in the dialog by changing the selection. Quickly set all bodies in the dialog as
a Part, Fixture, or Stock type. You can also set the Chord Height and add a Comment. Click Apply To All
to apply the new settings to all the bodies in the dialog.

Body Bag
To open the Body Bag window, from theMain palette, click Body Bag. You use the Body Bag
to organize theWorkspace by storing bodies during part creation. Double-click a body tomove it
from theWorkspace to the Body Bag. Tomove bodies between theWorkspace and the Body Bag,
you can also use the Bag It/Un-Bag It and Bag/Un-Bag Selected items. See the “BodyContext
Menu ” on page 11 and “Body Bag Context Menu” on page 19. Items in the Body Bag are active
when the Body Bag is open. For example, you can select, modify, andmachine items in the Body
Bag. Bodies in the Body Bag appear as icons that you can select, move, and resize.
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Resized Icons in the Body Bag

To arrange items in the Body Bag, you can drag the items. To display items in the Body Bag as
small icons, large icons, tiles, or as a detailed list, you use the View items. See “Body Bag Context
Menu” on page 19. You can also select the information you want to display for the items, such as
Solid ID and Solid CreationMethod.

About the Body Bag
Items displayed in the Body Bag are icons that include a snapshot of the bodywhen it wasmoved
into the Bag. Moving or resizing the icons does not effect the corresponding bodies. Icons are
unaffected by Floating Toolbar buttons such as Show Solids, Render/Wireframe, Indicate Sheet
Side, and color modes.

Tomove a body into the Body Bag:
Double-click the body in theWorkspace or right-click the body and choose Bag It from the context
menu. The object moves to a Body Bag page. The Body Bag page that the object moves to
depends on whether the object previously resided in the Body Bag:

l If the object previously resided in the Body Bag, it moves to the Body Bag page that last
contained it, and that page displays.

l If the object did not previously reside in the Body Bag, it moves to the Body Bag pagemost
recently displayed.

To increase or decrease the size of icons in the Body Bag:
Click in the Body Bag and select CTRL+mousewheel. The size of icons increases or decreases on
all Body Bag pages that are set to display bodies as Large Icons or Tiles. See “Viewing Body Bag
Pages ” on page 21.

Tomove an object from the Body Bag to theWorkspace:
Double-click the object on the Body Bag page. The object displays in theWorkspace.

Body Bag Context Menus
You can access the following context menuswhen working with the Body Bag:
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l “Body Bag Context Menu” on page 19
l “Body Bag Page Context Menu” on page 20

Body Bag Context Menu

To access the Body bag context menu, right-click anywhere in the
Body bag title area. The Body Bag context menu contains the
following items.

Clean Up Page:
Arranges the Body Bag icons on the selected Page so that you
can view all icons and none overlap.

Clean Up Body Bag:
Reorganizes the Body Bag icons so that you can view all icons
and none overlap.

Bag Selected:
Places any solids or sheets that are selected in the drawing
window into the Body Bag.

Un-Bag Selected:
Take any selected Body Bag icons and place the solids/sheets
back into the drawing window from the Body Bag.

Select/Deselect Body Bag:
Selects or deselects all of the bodies in the Body Bag. You can use this item to isolate problem
areas by analyzing surface files.

Select/Deselect Page:
Selects or deselects all the of the bodies on the Page.

Select/Deselect Workspace:
Selects or deselects all entities (including bodies and geometry) in theWorkspace. You can use
this item to isolate problem areas by analyzing surface files.

View:
Click View to display the following items.
Large Icons:
Display large Body Bag icons.

Small Icons:
Display large Body Bag icons.

Detail:
Display detail list of Body Bag icons.

Tiles:
Arrange Body Bag icons as tiles with Solid or Sheet
type, creationmethod, solid ID, chord height and
current CS.

Auto Arrange:
Automatically arrange Body Bag icons so that you can view all icons and none overlap.

Align to Grid:
Align Body Bag icons to a grid.
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Show Solid ID:
Show solid ID for Body Bag icons.

Show Solid CreationMethod:
Show solid creationmethod for Body Bag icons.

Body Bag Page Context Menu

To access the Body Bag Page context menu, right-click a Page tab at the bottom of the Body Bag
window. See “Body Bag” on page 17.With thismenu you can insert delete or rename pages.

Body Bag Color Display 
Objects in the Body Bag display in the following colors:

Color Body Type Selected or Unselected
Gray Solid Unselected.
Light blue Sheet Unselected.
Dark blue Stock Unselected.
Red Fixture Unselected.
Red Body in "Recreate" mode Selected.
Yellow Part (solid or sheet) Selected.
Striped red/yellow Fixture Selected.
Striped gray/black Stock Selected.

Note: Regardless of the color preferences you set, objects in the Body Bag display in the colors
listed in the table above.

Body Bag Pages 
You can add pages to a Body Bag to organize and categorize items in the Body Bag. To access a
page, click the tab for that page. To add, delete, and rename pages, you use the “Body Bag Page
Context Menu” on page 20. To reorder pages, click and hold a page tab, then drag the tab to the
new position.

You can createmultiple pageswithin the Body Bag. Each pagemaintains its own view settings.
When you create a new page, its view settings initiallymatch those of the last-viewed page.

You canmove objects from one Body Bag page to another by selecting and dragging to another
tab; as the cursor passes over the tab, a preview of the page displays. You can create a new Body
Bag page on the fly by dragging a Body Bag selection to an empty area to the right of the rightmost
tab.

To insert, delete, or rename a Body Bag page, right-click the corresponding tab. A tab name in gray
indicates an empty page. Only empty pages can be deleted.

You can select Clean Up Page from the context menu to perform a one-time Auto-Arrange on the
current page without modifying view settings. You can select Clean Up Body Bag from the context
menu to delete all empty pages and perform a Clean Up Page on all pages that remain.
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Viewing Body Bag Pages 
To display or modify the view settings of a page in the Body Bag:

1. Display the page
2. Right-click the Body Bag title bar, and select View.
3. Select the option you want. Refer to the table below to select the appearance you want.

Select Result
Large Icons or Small Icons Page displays each body's icon and name only.

Details or Tiles
Page displays each body's icon, name, type (Part, Stock, or
Fixture), resolution (chord height), and CS (coordinate
system).

Align to Grid Icons or tiles are prevented from overlapping.

Auto-Arrange

Overlapping and empty slots are prevented. An icon or tile's
location on the page depends on the Body Bag window size:
Icons move to fill the top row from left to right, then the
next row, if necessary, and so forth.

Selecting Body Bag Objects 
Selection sets can include bodies in one, some, or all Body Bag pages, and can include or exclude
Workspace items.

To select a body and deselect all others, click the body.

To add or remove a body in the selection set, Ctrl+click the body.

To select all objects in theWorkspace and the currently displayed Body Bag page, from the Edit
menu, click Select All.

• Edit > Select menu items (and Ctrl+A) operate on bodies in theWorkspace and the currently
displayed Body Bag page only.

• Edit > Deselect menu items and Edit > Invert Selection operate on all bodies, that is, the
Workspace and all Body Bag pages combined.

To select or deselect objects in all pages, right-click the Body Bag title bar and use context menu
itemsSelect Body Bag or Deselect Body Bag.

To add all of a bodies on a page to a selection set, from the Body Bag context menu, click Select
Page to specify the page. To remove all of a page's bodies from a selection set, use context menu
Deselect Page to specify the page. You cannot select or deselect empty pages.

Context menu items such as Bag Selected or Show Properties of Selected or User Color of
Selected operate on all objects in the selection set.
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Preferences
To accessGibbsCAMpreferences:

From the Filemenu, select Preferences.
This topic describes items on the Display tab that affect the graphic display of solids and sheets. To
view display preferences, click the Display tab. You can adjust the degree of faceting during render
operations. See “Render Faceting” on page 23.

You can display bodies as rendered solid objects or aswireframe
drawings. The Render/Wireframe button in the Floating toolbar
determineswhether solids and sheets are rendered as objects or
wireframe drawings. TheWire Drawing setting defineswhether it
displays edges or facets of bodies. For more information about
Preferences, see the CommonReference guide.

Display Preferences
To accessGibbsCAMpreferences:

From the Filemenu, select Preferences.
This topic describes items on the Display tab that affect the graphic display of solids and sheets. For
more information about Preferences, see the CommonReference guide.
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Wire Drawing:
Solids and sheets can be displayed as rendered
solid objects or aswireframe drawings. The
Render/Wireframe button in the Floating
Toolbar determineswhether solids and sheets
will be rendered objects or wireframe drawings.
This setting lets you determine whether the
system displays edges or facets of solids or
sheets depending on the selectionmade in the
Wire Drawing section.

Chord Height:
Enter the overall part chord height. The chord
height determines the faceting resolution when
solids and sheets are rendered. Click the Apply button to finalize the change to the faceting
tolerance for selected bodies, as well as setting the value for new bodies to be created in the
future. For more information on setting the Chord Height, see “Render Faceting” on page 23.

Render Faceting
Rendering is the process of displaying a picture of amodel on the screen.When bodies are
rendered, they are faceted. Facets are small planar surfaces that compose the renderedmodel.
Themore facets drawn, the closer themodel resembles the actualmathematical model and the
more time it takes for the system to render themodel. Faceting affects the quality of the rendered
bodies. It also affects overall system performance and speed. The faceting chord height should be
set at a value that balances the quality of themodel with system performance.

Note: The faceting tolerance does not affect onmachining tolerances, only on the rendered image
on the screen.

The tolerance used for surfacemachining is set locally in the Process dialogs Solids tab > Advanced
Settings dialog and is labeled as the Cutting Tolerance and globally in the Document Control dialog as
Use Global settings for Solids > Part Rough Tolerance. It is this specification which designates how
closely the toolpath will follow the surface.

The number of facets used to render amodel is determined by the chord height. A chord is a
straight line that joins any two points on an arc or circle. The chord height is the distance from the
chord to the arc or circle (see figure below). The smaller the chord height, the closer the facet will be
to the arc or circle, resulting in a better rendered image of the solid or sheet (this is a 2D description
of chord height; the system uses a 3D chord height for the faceting of solids and sheets, but the
general idea is the same).

1. Chord Height
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Chord Height

The system uses a global faceting chord height which is applied to the entire part model. The global
chord height is applied to all solids and sheets that are created or imported.

To set the global chord height:

1. Click File > Preferences. The Preferences dialog appears.
2. Click the Display tab.
3. Under Chord Height, type a number in the text box or drag the slider to change the value.

You can set a different faceting chord height to individual solids and sheets. The Properties dialog,
accessed by right-clicking on a solid or sheet, contains a chord height value which will only be used
to facet the selected solid or sheet. For more information, see Properties.

Extracting Geometry from Solids

Geometry from Solids
TheGeometry Creation palette contains a palette for extracting edges and holes:

1. Geometry Extraction
2. Hole Extraction

Geometry Extraction
Extracting geometry from selected faces or edges of a body is
based on a Tolerance. Connected shapeswill be created if the
selected edges create a closed loop. Click Do It in the
Geometry Extraction dialog to create the geometry.

Tolerance
If a resulting spline can be converted to lines or circles within the tolerance, it will be
converted. A large tolerance value will convert more of the edge splines to lines and circles,
while a tight tolerance will keep the entities as they are defined in the part model. A tolerance
of zero is recommendedwhen extracting geometry that is definitely a circle or a line.
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Hole Extraction
To create a circle from a hole in a body based on the Circularity
Tolerance, select the inner face of the hole or select the entire
model to extract all holes that can be defined in the current CS.

When using this function, either a solid or sheet can be selected and
the systemwill scan the faces of the selection and find all holes. A
holemust have walls which are perpendicular to the current CS. Additionally, the edge loop of the
holemust be either a circle or a spline; it cannot be a polyline (line segments approximating a circle).
When hole extraction is performed, the resulting geometry will all be circles. Any hole edge loops
which are splines but fall within the Circularity Tolerance specified will be extracted as circles. Edge
loopswhich are splines that do not approximate a circle within the given tolerance will not be
extracted. The depth of the extracted geometry will be based on the bottom of the hole(s), making it
easy for the user to determine the depth for the drilling operation.
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Conventions
GibbsCAMdocumentation uses two special fonts to represent screen text and keystrokes or
mouse actions. Other conventions in text and graphics are used to allow quick skimming, to
suppress irrelevancy, or to indicate links.

Text

Screen text.  Text with this appearance indicates text that appears in GibbsCAMor on your monitor.
Typically this is a button or text for a dialog.

Keystroke/Mouse.  Text with this appearance indicates a keystroke or mouse action, such as
Ctrl+C or right-click.

Code.  Text with this appearance indicates computer code, such as lines in amacro or a block of
G-code.

Graphics

Some graphics are altered so as to de-emphasize irrelevant information. A “torn” edge signifies an
intentional omission. Portions of a graphicmight be blurred or dimmed to highlight the item being
discussed. For example:

Annotations on a graphic are usually numbered callouts (as seen above), and sometimes include
green circles, arrows, or tie-lines to focus attention on a particular portion of the graphic.

Faint green borders that outline areaswithin a graphic usually signify an imagemap. In online help
or a PDF viewer, you can click a green-bordered area to follow the link.
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Links to Online Resources

Link URL Action / Description

Go http://www.GibbsCAM.com Opens themain website for GibbsCAM.

Go https://online.gibbscam.com

Opens a restricted website containingmaterials
available for download. Requires aGibbsCAM
Online Services account; to set up an account,
contact GibbsCAM Support.

Go https://store.GibbsCAM.com
Opens the website for the GibbsCAM Student
Store.

Go https://macros.gibbscam.com
Opens a wiki containing documentation and
examples of GibbsCAMmacros. Requires a
GibbsCAM account.

Go http://kb01.GibbsCAM.com

Opens a Knowledge Base article, Contour
Operations Using Thread Mill Tools, that
explains in detail the correct way to program
Contour processes using ThreadMill tools.

Go mailto:Support@gibbscam.com
Runs your email client to create a new message
addressed to the CAMBRIO Technical Support
department for GibbsCAM.

Go mailto:Registration@gibbscam.com
Runs your email client to create a new message
addressed to the CAMBRIORegistration
department for GibbsCAM.

Go mailto:Sales@gibbscam.com
Runs your email client to create a new message
addressed to the CAMBRIO Sales department
for GibbsCAM.

Go http://www.autodesk.com/inventor
Opens an external website that provides more
information on Autodesk Inventor products.

Go http://www.celeritive.com
Opens an external website that provides more
information on VoluMill Ultra High-Performance
Toolpath (UHPT) from Celeritive Technologies.

Go http://www.predator-software.com
Opens an external website that provides more
information on a CNC editor and a virtual CNC
viewer from Predator Software, Inc.

http://www.gibbscam.com/
https://online.gibbscam.com/
http://store.gibbscam.com/
https://macros.gibbscam.com/
http://kb01.gibbscam.com/
mailto:Support@gibbscam.com
mailto:Registration@gibbscam.com
mailto:Sales@gibbscam.com
http://www.autodesk.com/inventor
http://www.celeritive.com/
http://www.predator-software.com/
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